
 

PLEASE ! PAY TO PLAY, OR EVERYONE LOSES

 

Whenever you play at a private club or public links, part of the fee you pay for the privilege
goes toward maintaining and improving the course. If everyone climbed over the fence to
play without paying, the grounds and facilities of our beautiful courses would eventually
grow untended and become unpleasant. Some clubs might be able to survive by raising
their prices (to more than most of us can afford). But most courses would be driven out of
business. That’s a depressing thought!

A developer of computer simulations, like a country club or public course, uses the money
it makes from its products to stay in business. If potential customers steal its goods and
services, the developer must raise prices to compensate for the losses. Soon legitimate
customers can’t af ford to pay the higher prices; the company closes, and everyone loses.

PGA TOUR® Golf was produced for your enjoyment through the combined efforts of a ded-
icated team at Electronic Arts. We––designers, artists, programmers, and other committed
workers––depend on you to pay a fair price for our software so we can earn the money
required to create and develop new and better entertainment products. We encourage you
to play and enjoy PGA TOUR Golf with your friends, but please don’t make illegal copies of
the program for them.

As a member of the Software Publishers Association (SPA), Electronic Arts supports the
fight against the illegal copying of personal computer software. Thank you for helping us in
our effort to control software costs by eliminating software theft. And please remember,
copying computer software without permission is a violation of federal law.
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PGA TOUR® GOLF: FROM TEE TO GREEN WITH THE GREATEST PLAYERS IN THE WORLD

Welcome to PGA TOUR® Golf, a close-up, inside look at what’s been called “the greatest
sport man has ever devised.” PGA TOUR Golf lets you play like a pro against the TOUR’s
most competitive players on some of the finest golf courses in the world. It’s you against
a choice field of 60 PGA TOUR professionals. And, on any given day, you could win it all.

PGA TOUR Golf will stretch your skills and psychological strength to the limit. Just like your
favorite TOUR players, you’ll need to size up and execute special shots from a variety of
lies, rise above the exhausting pressure of a win-it-all putt from the fringe, and defend your
hard-earned reputation as a master of coordination, timing, deftness of touch, and sheer
power. The game consistently demands your finest effort: only when you give your best will
you make it to the top of the leaderboard.

It’s THE PLAYERS CHAMPIONSHIP at the Tournament Players Club [TPC] at Sawgrass. Pick
the right club, make the perfect swing and experience the thrill of making a birdie on the
famous 17th hole. Later you can blend your skill and discipline to tame the mountainous
bunkers and undulating swales of PGA West Stadium Course [TPC at La Quinta]. Or try to
reach the notorious tiered green of the 13th at the TPC at Avenel with a middle iron, shoot-
ing through a driving cross-wind.

These are just a sampling of the exciting challenges you’ll face in PGA TOUR Golf. You’re
about to experience everything offered by the real game except the dirt from a divot and an
unexpected cloudburst. If you’re ready for great action and realistic play, let’s install the
game, and get right down to the Pro Shop.
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INSTALLING AND STARTING PGA TOUR® GOLF

Boot your computer with DOS (any version between 2.0 and 3.3) before installing or start-
ing PGA TOUR Golf. If you don’t have a hard disk, skip the next section, HARD DISK USERS,
and turn to page 5, for instructions on how to install PGA TOUR Golf on a floppy system.

Hard Disk Users

To install PGA TOUR Golf you need to copy both of your game disks onto your hard disk:

1. Type C: and press Enter. ( If your hard disk isn’t drive C, type in the appropriate
drive letter.)

2. Type MD\GOLF and press Enter.
3. Type CD\GOLF and press Enter.
4. Insert the PGA TOUR Golf Program Disk into floppy drive A or B.
5. Type COPY A:*.* and press Enter. (If you inserted the Program Disk into a dif-

ferent floppy drive, replace A with the correct letter.)
6. After the Program Disk is copied, remove it from the drive, insert the PGA TOUR

Golf Course Disk and repeat step 5. Note: If you’re using a 3.5 inch disk, you
need to only copy one disk.

7. When the copy is complete, remove the Course Disk from the drive and store the
original floppy disks in a safe place, away from heat, moisture, magnets, sand
bunkers, and water hazards.

Starting the Game

Note: You can play PGA TOUR Golf with a mouse, a joystick, or directly from the key-
board. 

Tandy Users: If you have two joysticks plugged into your computer, use Joystick
#2 to play PGA TOUR Golf. If you only have one joystick, plug it into Port #1.

To star t PGA TOUR Golf from a hard disk:
1. Type C: (or whatever letter designates your hard drive) and press Enter. 
2. Type CD \GOLF and press Enter.

* If you want to run PGA TOUR Golf in a particular graphics mode, see Special
Loading Features, on page 8. After you’ve completed the instructions in that sec-
tion, come back here and continue the start-up routine beginning with step num-
ber 4.

 

If you don’t want to issue any special loading instructions at this time, but
would just like to begin the game:4



3. Type GOLF and press Enter. 
4. Once the game loads, the title screen appears followed by a credit screen. Press

the spacebar, mouse button, or joystick button to continue.

Answer a Question, Please.

A grid with yardage markers has appeared on the screen. To get to the Pro Shop so you can
begin to play PGA TOUR Golf, you need to answer one quick question.You do that by select-
ing the correct yardage for the hole listed at the bottom of the screen.

1. Turn to the reference card. You’ll find scorecards with yardage markers for three
Tournament Players Club [TPC] courses. Note the number that corresponds to the
course, hole, and tees (TPC, Blue, White, or Red) listed at the bottom of your
screen.

2. You need to highlight the matching number on the grid so you can move on to the
Pro Shop. If you’re using a:

Mouse: Move the cursor arrow to the appropriate number and click a mouse
button to highlight the number. Then click OK (or press Enter).

Joystick: Use Up/Down, Left/Right on the joystick to move the highlight to the
appropriate number. When the number is highlighted, press either joy-
stick button.

Keyboard: Use the directional arrows on the keypad to move the highlight to the
appropriate number. When the number is highlighted, press Enter.

In a moment you’ll be at the Pro Shop. From there you can go out to practice your strokes
or begin a tournament round.

If you’re playing PGA TOUR Golf from a hard disk, you can move directly to the section called
Fundamentals, on page 9.

Floppy Disk Users

Before playing the game, you need to copy the PGA TOUR Golf disk(s) onto your own floppy
disk(s). Copies prevent your original disk(s) from being accidentally damaged while in use,
and guarantee that you’ll be able to make future copies of the game. 

One Drive Systems

To copy PGA TOUR Golf with a one drive system, you’ll need a blank, formatted floppy disk
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(or two if you’re using 5.25 inch disks).

1. Put your DOS disk in drive A. Type A: and press Enter.
2. Type DISKCOPY and press Enter. 
3. When you’re asked to enter the source disk, insert the PGA TOUR Golf Program

Disk into the drive and press Enter. The computer will tell you when to insert the
destination disk (the blank disk) and when to reinsert the source disk (Program
Disk).

* DO NOT WRITE PROTECT YOUR COPY OF THE PROGRAM DISK. SAVED PLAYERS
AND SAVED GAMES WILL BE STORED ON THE PROGRAM DISK.

Note to 5.25 Inch Disk Users Only:

4. Repeat steps 2 and 3 to copy the PGA TOUR Golf Course Disk.

Two Drive Systems

Follow this procedure if both of your drives are the same size. If your drives are not the
same size, follow the instructions for one drive systems, above. To copy PGA TOUR Golf with
a two drive system, you’ll need a blank, initialized floppy disk (or two if you’re using 5.25
inch disks).

1. Put your DOS disk in drive A. Type A: and press Enter.
2. Type DISKCOPY A: B: and press Enter.
3. You’re prompted to insert the source disk in drive A and the destination disk in

drive B. Insert the PGA TOUR Golf Program Disk in drive A and the blank disk in
drive B; press Enter. 

* DO NOT WRITE PROTECT YOUR COPY OF THE PROGRAM DISK. SAVED PLAYERS
AND SAVED GAMES WILL BE STORED ON THE PROGRAM DISK.

Note to 5.25 Inch Disk Users Only:
4. Repeat steps 2 and 3 to copy the PGA TOUR Golf Course Disk
* DOS commands may vary. If you have any difficulties with this disk copying rou-

tine, refer to your DOS manual for specific information on copying disks.

Starting the Game

Note: You can play PGA TOUR Golf with a mouse, a joystick, or directly from the key-
board. If you want to use your mouse, make sure your mouse driver software [not
provided by Electronic Arts] is installed before you start the game. Check the doc-
umentation that came with your mouse for more information. If you’re playing with
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a joystick, make sure it’s plugged into port #1 of your computer. 

Tandy Users: If you have two joysticks plugged into your computer, use Joystick
#2 to play PGA TOUR Golf. If you only have one joystick, plug it into Port #1.

To start PGA TOUR Golf from a floppy disk:

1. Insert your copy of the PGA TOUR Golf Program Disk into drive A or B.
2. Type A: or B: (whichever drive you put the disk in) and press Enter.
* If you want to run PGA TOUR Golf in a particular graphics mode, see Special

Loading Features, on page 8. After you’ve completed the instructions in that sec-
tion, come back here and continue the start-up routine beginning with step num-
ber 4. If you don’t want to issue any special loading instructions at this time, but
would just like to begin the game:

3. Type GOLF and press Enter. 
4. Once the game loads, the title screen appears followed by a credit screen. Press

the spacebar, mouse button, or joystick button to continue.

Answer a Question, Please

A grid with yardage markers has appeared on the screen. To get to the Pro Shop so you can
begin to play PGA TOUR Golf, you need to answer one quick question. You do that by select-
ing the correct yardage for the hole listed at the bottom of the screen.

1. Turn to the reference card. You’ll find scorecards with yardage markers for three
Tournament Players Club [TPC] courses. Note the number that corresponds to the
course, hole, and tees (TPC, Blue, White, or Red) listed at the bottom of your
screen.

2. You need to highlight the matching number on the grid so you can move on to the
Pro Shop. If you’re using a:

Mouse: Move the cursor arrow to the appropriate number and click a mouse
button to highlight the number. Then click OK (or press Enter).

Joystick: Use Up/Down, Left/Right on the joystick to move the highlight to the
appropriate number. When the number is highlighted, press either joy-
stick button.

Keyboard: Use the directional arrows on the keypad to move the highlight to the
appropriate number. When the number is highlighted, press Enter.

In a moment you’ll be at the Pro Shop. From here you can go out to practice your strokes 7



or begin a tournament round.

Special Loading Features

PGA TOUR Golf automatically detects and selects the best graphics mode for your comput-
er. There might be times, however, when you’ll want to change the graphics mode, to give
the game a different “look.” For example, maybe your computer is capable of handling EGA
mode, but you’d rather view the game in CGA mode.

To change the graphics mode of PGA TOUR Golf, you need to type an argument after the
loading command, GOLF. The arguments you can use are:

V Run the game in VGA mode
E Run the game in EGA mode 
T Run the game in Tandy graphics mode 
C Run the game in CGA mode 
H Run the game in Hercules mode 

Add a space between the loading command and any argument.

Let’s say you want to load the game in CGA graphics mode. You’d type Golf C and press Enter. 

Sound Board

The game automatically detects the presence of a sound board in your computer. If you
have more than one sound board, the game will choose the first one it finds, based on the
following order:

MIDI board, including Roland MT-32™
AdLib™ board
CMS board
Tandy®

PC Speaker

If you do not wish to enter any special instructions at this time, simply type GOLF and press
Enter. If you’re loading PGA TOUR Golf for the first time, return to step 4 in the start-up rou-
tine on page 4 or 7 for more information.
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FUNDAMENTALS

Every pro who qualifies for the PGA TOUR knows that golf is a game of fundamentals. The
elegant simplicity of the game accounts for its enormous popularity and for the frustration
most of us feel when we don’t keep our heads down. But we shouldn’t feel too badly; even
the greatest pros return repeatedly to their teachers for reminders about watching the ball,
proper swing mechanics, and body rotation. 

Golf begins and ends with fundamentals; without them the occasional great shot, the
superb sand save, the hole-in-one, are just accidents. As it is on the real PGA TOUR, so it
is in PGA TOUR Golf. You’ve got to master the fundamentals to play with the big boys.
They’ve been practicing and perfecting their games for years and now it’s your turn.

The game offers a number of options to help you learn and practice the fundamentals of
playing on the PGA TOUR. To learn how to hit the ball properly, using a variety of clubs, you
can go to the Driving Range. To practice putting, go to the Putting Green. Or you can try a
Practice Round when you’re ready to put it all together. 

All of the action begins in the Pro Shop. 

The Pro Shop––Making Selections

You start PGA TOUR Golf in the Pro Shop. From here you’ll select most of your play options.
Notice the menu titles at the top of the screen. You can select options from any of these
menus using the keyboard, the mouse or joystick.

For a list of the menu options and details on how to use them, see The Pro Shop and the
PGA Tour Tent, page 23.

Making Selections with the Keyboard

You can select menus and play options from the keyboard simply by pressing the corre-
sponding highlighted letter. You can look at the options in any menu simply by pressing the
first letter in the menu’s name. Or, when a menu is showing, you can expose a different
menu by pressing the left- or right-arrow keys. Menus and menu options which share the
same keyboard command (for example, Play menu and Practice Round can both be
accessed by pressing P) are never available for selection at the same time.

Making Selections with the Mouse

Point the cursor arrow at the menu title (Play, File, View etc.) you want to use. When it’s
highlighted, click a mouse button. Then point the cursor arrow at the menu option you want 9



to choose, so the option is highlighted, and click a mouse button again.

Making Selections with the Joystick

Use joystick button 2 to access the menus of PGA TOUR Golf. Move the joystick left or right
to display dif ferent menus. Move the joystick up and down to highlight different options on
the displayed menu. Press joystick button 1 to make the selection. Make subsequent selec-
tions by moving the joystick, which moves the highlight. Press joystick button 1 to accept
the option, button 2 to cancel.

Escape Key

All users can press the Escape Key to move back one “layer” in the game. If, for example,
you want to go to the immediately previous screen, press Escape, and you’ll return to it.
Multiple presses are allowed. Pressing Escape in the Pro Shop or the PGA TOUR Tent exits
you to DOS. You’ll be prompted to save your game.

Driving Range

To prepare for your upcoming tournaments, you’ve got to do more than buy a new pair of
shoes (although that wouldn’t hur t). A little practice seems in order. Put your new clubs to
work by heading off to the Driving Range. Be sure to experiment with your woods and your
irons. And keep your eye on the wind gauge; you’re not playing under a dome, you know.
When you’re ready to start, move the highlight to Driving Range on the Play menu and click
a mouse (or use the joystick or keyboard). 

All three professional courses and your home course, Sterling Shores, have Driving Ranges.
Select the course of your choice and click OK.

* If you’re not using a mouse, you can use the up- and down-arrow keys (≠ and Ø) on your
keyboard to move through the list of courses. Press O or Enter to confirm your choice.

Fore! Hitting the Ball with the Stroke Bar

The Stroke Bar displays the distance potential of your selected club, and it lets you control
the power and accuracy of your swing.

To hit the ball, you need to press the Stroke Button (spacebar, left mouse button, or joy-
stick button 1) three times in succession. The first press (1) starts your backswing; the
second (2) ends your backswing and determines the power of your stroke; the third (3) hits
the ball and determines whether the shot will hook, slice, or travel straight.
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1. Press the Stroke Button to start your backswing. The Power Bar quickly extends
left from the Accuracy Point, indicating the growing strength of your backswing.

2. Press the Stroke Button to stop your backswing. Each club has a distance
potential, which appears in a box to the left of the Stroke Bar. The percentages
below the Bar indicate the percent of the total distance potential you want to use.
When the Power Bar reaches the strength you want, press the Stroke Button to
stop it. The Bar begins to shrink back toward the Accuracy Point, leaving a small
line that marks the spot where you stopped it.

3. Press the Stroke Button to hit the ball. To hit the ball straight, press the Stroke
Button when the Power Bar returns to the Accuracy Point. If you stop the Bar
exactly on the Accuracy point, you’ll hit the ball straight. If you press the Stroke
Button before the Bar reaches the Accuracy Point, the ball hooks to the left. If you
press the Stroke Button after the Bar has moved beyond (to the right of) the
Accuracy Point, the ball slices to the right.

For example, let’s say you’re at the tee and are ready to use your driver whose distance
potential is 260 yards. If you press the Stroke Button (the second press) when the Power
Bar is at 75%, your shot’s calculated distance will be 195 yards (260 x 0.75 = 195). The
actual distance of your stroke varies from the calculated distance depending on the wind,
the type of terrain on which your ball lands, the lie of the ball, and your accuracy.

You can also let the Power Bar extend beyond 100% to give the stroke more power than you
can accurately control. If you hook or slice the ball with more than 100% power, any errors
you make when you hit the ball (the third press) will be exaggerated.

Info Box

The Info Box at the Driving Range displays the club you’re practicing with.

To select a different club:
Mouse: Move the cursor into the Info Box, and click either mouse button.
Joystick: Move the joystick up to increase the number of the club or down to

decrease it.
Keyboard: Press the up or down arrows on the keypad to change the number of the

club.
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Notice how the distance potential in the Stroke Bar changes as you change your club. When
you’re playing a tournament round, your “caddy” will give you the club he thinks is appro-
priate for the shot, but the final choice is yours. If possible, choose a club with a distance
potential that exceeds the distance to the pin, so you can maintain control of your stroke,
particularly if you plan to intentionally hook or slice your shot.

Note:  These are total distances, not aerial distances. If you try to carry a 4 wood (distance
potential, 224 yards) over a water hazard 200 yards away, you probably ought to
teach your ball how to swim. Remember, that these distance potentials assume a
perfect lie, no wind, and a flat spot for the ball to land on so it can bounce and roll. 

Aiming Your Shot
The aiming cross hair (flashing in the middle of your screen) indicates the direction the

ball will travel if it is well -hit. To change the position of the cross hair:

Mouse: Move the mouse cursor to the direction you want, and click the right mouse
button to fix the cross hair in the intended target area.

Joystick: Move the joystick left or right.

Keyboard: Press the left or right arrows (← or →) on the keypad.

Wind

The rotating arrow indicates the wind speed and direction. Watch out for occasional wind
gusts!

Adjust the direction and strength of your strokes to compensate for the wind.

Go to a Different Driving Range

You can go to the Driving Range of any other course by selecting New Course from the Go
To menu. Then make your selection. If you want to return to to the Pro Shop select Pro Shop
from the Go To menu or press Escape.12

Club range
Type (Yards)

Driver 260

2 Wood 248

3 Wood 236

4 Wood 224

5 Wood 212

1 Iron 227

2 Iron 215

3 Iron 203

4 Iron 191

5 Iron 179

6 Iron 167

7 Iron 155

8 Iron 143

9 Iron 131

Pitching Wedge 119

Sand Wedge 100

Putter *

Club Distance Potentials
*You can adjust the putter’s distance

potential between 5 and 120 feet,
in 5 foot increments.



Putting Green

We all know solid players who are long off the tee, with strong middle irons, and sweet
short games, whose concentration completely falls apart once their ball hits the so-called
“putting surface.” [The very mention of the word Green gives them the yips.]. PGA TOUR
Golf can help you avoid the dreaded y-word. You can practice putting on different greens,
and learn how to really “read” them. If you want to practice your stroke now, select Putting
Green from the Play menu.

Grid View

When you select Putting Green, a grid showing the topography of the first practice hole’s
putting sur face appears on the screen. A message above the contour grid reports the dis-
tance to the cup, and how far your ball is above or below the pin. To get a better view of
how the topography of the green will affect the roll of the ball as you putt, use the F1 and
F2 keys to move the grid, so the ball and the cursor are in alignment. Use the grid and the
message to determine the appropriate direction and speed of your putt. As it says on the
screen, you can use the left and right arrows to move the aiming cursor. 

Click the left mouse button, joystick button 1, or press the spacebar to move to the putting
green. The aiming cross hair on the green reflects any aiming adjustments you made on the
grid. There’s no need to re-aim. If you wish to see the grid again, choose Green from the
View menu (or press G after pulling down the View menu).

How to Putt

The Stroke Bar on the Putting Green works exactly like the Stroke Bar at the Driving Range.
See the “Driving Range” section for a description of the Stroke Bar.

When on the green, you always use a putter. Sorry, no trick clubs allowed! The distance
potential of your putter can be adjusted in increments of 5 feet over a range of 5 to 120
feet. To change the distance potential with a:

Mouse: Move the cursor into the Info Box, and click either mouse button.
Joystick: Move the joystick up or down.
Keyboard: Press the up or down arrows on the keypad.
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Info Box

The Info Box on the putting green displays your club type and the distance to the pin.

Aiming Your Putt

The flashing cross hair indicates the direction the ball will travel, if you hit it squarely. As
with any ball you hit in PGA TOUR Golf, you’ll pull the ball to the left if you hit too early, or
push it to the right if you hit it late. To change the position of the cross hair with a:

Mouse: Move the mouse cursor to the direction you want, and click the right mouse
button to fix the cross hair in the intended target area.

Joystick: Move the joystick left or right.
Keyboard: Press the left or right arrows (← or →) on the keypad.

*    Changing the position of the cross hair on this screen has the same effect as chang-
ing its position on the grid.

Short Putts

You’ll sink short putts with ease if you play them like the pros do (and avoid the yips). For
putts of 5 feet or less, go straight for the hole and make sure you don’t baby the ball. As
it is on the PGA TOUR, so it is in PGA TOUR Golf: No guts, no glory!

Go to a Different Hole

To go to a different hole on the course, select Hole from the Go To menu. Select the hole
you want, and then select Ok.

Go to a Different Course

To go to a different course, select New Course from the Go To menu. Select the course you
want, and then select Ok. To leave the Putting Green and return to the Pro Shop, select Pro
Shop from the Go To menu, or press Escape.

Practice Round

Rather than just hanging around the Pro Shop swapping stories with the caddy master, you
might think about shooting a practice round. To play a practice round on any course, choose
Practice Round from the Play menu. 
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You’ll be asked to make a few selections from the dialog boxes that will appear automati-
cally.

First the game asks how many players are practicing this round [Select Number of Players];
second it asks who is playing [Human or Computer Players]; then you’re asked whether you
wish to register as a New player or load a previously Saved (Old) Player; if you choose New
Player, type in your name on the replica of a PGA TOUR Player’s Card; select Professional
or Amateur Tees, choose the clubs you want to bring on your round. PGA rules require that
you have no more than 14 clubs in your bag. If you hit the long ball well, take some long
irons and an extra wood on your round. If your short game needs some work, make sure
you have a full complement of short irons. Finally, select any one of the four golf courses.

In a moment an overview of the course you chose appears on the screen. The next thing
you see is an expanding fly-by view of the first hole on your course. If you chose a TPC
course, this fly-by will be accompanied by a brief commentary from one of the ten profes-
sional golfers featured in PGA TOUR Golf. Ignore this advice at your peril! The fly-by is fol-
lowed automatically by an overhead view of the hole. A flashing dot marks the tee and a
dark dot opposite to it marks the pin placement on the green. To return to the tee, press
the spacebar, a mouse button, or a joystick button.

Note: In general, you can speed up any screen transition, as from the fly-by view to the
overhead, by pressing the left mouse button, joystick button 1, or the spacebar.

The Tee

Hitting the ball from the tee works just like hitting at the Driving Range or Putting Green.
The Info Box displays useful additional information. It now tells you what hole you’re on, the
number of strokes you’ve taken, the current distance to the pin, par for the hole, and your
status compared to par so far this round (E means Even Par). The current player’s name
appears in the upper right corner of the screen. You face the target fairway from each tee,
or you face the pin when it’s within range. Plan your shot accordingly.

OVERHEAD VIEW (F5)

Any time you want to look at an overhead view of the hole, select Overhead from the View
menu (or press O on the keyboard, after you’ve pulled down the View menu). This view dis-
plays the path (called vectors) traveled by your previous shot(s). From this view you can eas-
ily see how much trouble you’re in, or, to keep a good thought, how much trouble you nar-
rowly avoided. To return to the course, press the spacebar, either mouse button, or a joy-
stick button. 15
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TAKE A MULLIGAN (F2)

If you want to try a stroke again, just for practice you understand, select Take a Mulligan
from the Options menu, and you can take the shot over. You can take multiple mulligans
and even “mulligan” your way back to the tee, if you wish.

BALL LIE (F3)

Choose Ball Lie from the View menu to see how your ball is sitting on the grass or in the
sand. Every PGA TOUR pro knows that ball lie will affect your choice of a club and the stroke
you use. If you land in the rough, for example, your irons will have a lower distance poten-
tial and less accuracy than if you were hitting from the fairway. For more information on Ball
Lie and club selection, see the Strategy Guide, pages 18-22.

SPECIAL SHOTS

PGA TOUR Golf lets you hit three types of unique shots on the course. If we hit all the
greens in regulation, we probably wouldn’t need this flexibility. But sometimes, the ball
doesn’t go exactly where you want it to. Sometimes you have to make a special shot. When
that happens, choose Special Shots from the Options menu. From there you can choose
to Chip, Punch, or Putt from the Fringe. For tips on how to use these useful shots, see the
Strategy Guide on pages 18-22.

INSTANT REPLAY (F1)

Choose Instant Replay to see your last shot again. Spectacular shots are automatically
replayed.

16



TOURNAMENT PLAY

Playing a Tournament and learning to drive a car have one thing in common: you don’t know
how it feels to do it until you do it. You can hone your strokes on the practice tee, or work
all the controls while the car is in the garage, but until you tee it up for money or pull out
into 5:00 o’clock rush hour, you really don’t know how you’ll perform.

PGA TOUR events put a premium on preparation, mental toughness, coordination, and the
will to win. If you think you’re ready for the exhilarating challenge of tournament play, say
good-bye to your buddies in the Pro Shop and choose Tournament from the Play menu.

HOW TO PLAY

When you choose Tournament, you’ll be asked a series of questions. You just can’t walk
into a PGA TOUR Golf event unannounced, you know. For now, just press Enter in response
to each question to accept the default choice. When you’re asked to enter your name, type
it and press Enter. When you’re done, an overhead shot of the entire course appears, fol-
lowed by a fly-by of the first hole and then you arrive on the tee.

After you make all your usual selections, you are introduced to the tournament and the total
prize money being offered.

Then you see the Leader Board which shows the current ranking for all tournament par tic-
ipants.

Following each ranking is the player’s name, score, and the hole he is currently playing.

During tournament play, you cannot change courses or holes, and no Mulligans are allowed
(so keep your head down).

If you score among the top 48 players after Round 1, you make the cut and move on to
Round 2. You have to place in the top 32 to get to Rounds 3 and 4.
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STRATEGY GUIDE

PLAY PGA TOUR Golf like a Pro––Take Your Best Shot!

In this Strategy Guide we outline how to play through most of the situations you’ll confront
while you play the challenging courses in PGA TOUR Golf. We chose the nasty 529 yard par-
5 11th hole from the Tournament Players Club at Sawgrass as a representative hole
because it includes every element that a TOUR pro must consider during a complete tour-
nament round. In THE PLAYERS CHAMPIONSHIP, which is played every year at Sawgrass,
the daunting and treacherous 11th has demolished the dreams of more than one tourna-
ment hopeful. With practice, skill, and judgement you can avoid this fate.

Off the Tee 

Like all the great pros, you should strive for consistency and good placement off the tee. If
you hit like a gorilla but can’t control the ball, you’ll find yourself in trouble on most of your
second shots. Keep in mind that all the TPC courses are designed to penalize risky shots
that turn out badly. Watch the aerial fly-bys for important club selection and ball-location
comments from our 10 featured PGA TOUR pros. They have already learned the rule that it
is better to be 20 yards shorter and in the fairway than to be long and in the rough (or
worse).

How Far Can You Hit It––Club Distance Potential

It is impor tant to understand that the distance potential listed to the left of the Stroke Bar
defines an AVERAGE shot hit at 100% power with no wind, and includes the ball’s flight in
the air PLUS roll. Remember this when you’re about to hit over a sand trap or water haz-
ard: When you have a choice between two clubs––always choose the longer one. You’ll land
where you wanted to be more often if you use this rule throughout your play. 

Overswing––Risk vs. Reward

The area to the left of the 100% Power mark on the Stroke Bar is reserved for what we call
“overswing.” The farther you let the Power Bar go into this area the farther you will be able
to hit the ball. But, as with all good things, there’s a price to pay. If you don’t hit the shot
perfectly, that is, smack the ball precisely at the Accuracy Point, the ball can, and most like-
ly will react erratically because you aren’t in total control of your swing. Remember: The
greater the deviation at the top or bottom of the swing, the more unpredictable the outcome
of the shot. Usually, you will not appreciate that outcome. 
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A word for the prudent player

Do not stray into the Overswing area if you’re trying to hook (draw), or slice (fade) your shot.
Overswing, by definition, eliminates reliability even when you’re playing the ball straight. It
will make your intended hook or slice wildly unpredictable.

Toyed with by the Elements

While your ball is traveling through the air, it will be battered around by the wind. Adjust your
aim to compensate for the direction and strength of the wind. CHECK THE WIND GAUGE!
It’s more informative than throwing a clod of grass in the air. The stronger the wind, the
more of an adjustment you should make. The Driving Range is an excellent place to test
your ability to adjust for the wind. 

Playing Your Second Shot

Horrible Lies

No, we’re not talking about your IRS returns. We mean ball lies. Let’s say you hit your drive
on the money. Terrific, but where did it land? You’ve got to check your ball lie. Other than
distance to the hole (which PGA TOUR Golf’s automated club selection helps you with), a
TOUR pro worries the most about his ball lie. That is, how is the ball sitting on the grass or
in the sand? Ball Lie is so important because it affects the amount of backspin you can
impart to the ball, how far each club can hit the ball, and how the ball reacts to an imper-
fect swing (overswing, hook, and slice). The worse your ball lie, the more these factors
affect your shot. The following is a list, from best to worst, of all possible ball lies in the
game: 

1. Teed Up 6. Half-Buried in Light Rough
2. Fairway/On Fringe (of green) 7. Buried in Sand Trap
3. In Divot in Fairway 8. In Heavy Rough
4. In Light Rough 9. Half-Buried in Heavy Rough
5. In Sand Trap

On the Beach––How To Play Out Of A Fairway Sand Trap

If your ball isn’t buried in the trap you can hit all of your irons between 50 and 90 percent
of their distance potential. When you’re in trouble, resist the temptation to try a spectacu-
lar saving shot and concentrate on getting your ball back into play (on the fairway or green).
Play conservatively out of the sand and you’ll save a lot of pars. If your ball is buried in the
sand, it’s risky to hit any club longer than a 4 iron. The danger of flubbing a shot out of that
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lie is too great to risk the few extra yards you might get with a longer club.

The Punch Shot (F8)

When you’re half-buried in the rough, or buried in the sand, select Special Shots from the
Options menu and choose Punch Shot. Use the punch shot to just get the ball back to the
fairway from whatever trouble your ball may have found. The distance the ball will travel is
shorter than if you took a full swing at the ball, but you’re not likely to flub or whiff the shot
or shank it and have it sail wildly off your clubface. 

Go For The Green In Two?––Only for the Brave

On this hole you would have to hit a very big drive (300 yards or more) and then cross an
ocean of sand to have a reasonable chance of reaching the green in two. Remember that
the distance potential listed next to the Stroke Bar is the amount the current club will go in
the air PLUS roll. If you are 240 yards away from the pin and try to hit a 3-wood to the green,
your ball will skip off the back of the green (IF, repeat IF, you are able to hit the green on
the fly with this club). A better strategy would be to either: a) take less than a full swing
with the 3-wood and try to bounce it onto the green; or b) hit a long iron with overswing and
try to fly the ball to the green (via the overswing). The safest play on this hole is to lay-up
short of the green and get set up for your third shot, the approach. 

Approaching the Green

Check Your Ball Lie — The importance of your Ball Lie cannot be overemphasized. You
should check it out before almost every shot you hit!

The Chip Shot (F7)

If you are close to the green, or on the fringe, this is the perfect time to use your Chip Shot
(select Special Shots from the Options menu and choose Chip Shot). This shot will not fly
very far in the air. The strategy of the shot is to fly the ball just on to the green and hope
it rolls the rest of the way to the hole. If you choose to use the Chip Shot you should look
at the Grid View of the green to read the contours of the green between you and the hole.
The moment your ball hits the green it will react to these contours. IMPORTANT! It is not
advisable to use the Chip Shot out of the following lies: 
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Half-Buried in Light Rough In Heavy Rough
In Sand Trap Half-Buried in Heavy Rough
Buried in Sand Trap

Warning: A ball hit as a Chip Shot will stop dead in its tracks if it lands on the fringe.

Playing To The Green From A Bunker 

Ball lie in the bunker is critical. If your ball is “sitting up” (that is, not buried) it will not roll
as far when it hits green as it would if it had been buried. Remember this when you’re think-
ing about how hard to swing at a sand shot. If you are playing your shot out of a trap beside
the green, look at the Grid View of the green to see its contours. The ball will be affected
by these contours the moment your ball hits the green. 

Backspin––How To Use It

The ability to control the ball with backspin is one of the skills that separates the pros from
most of the rest of us. Still, it’s never too late to learn, and if you want to play on the TOUR,
it’s a necessity. So take a lesson in hitting with backspin.

Since any ball you hit with the shor ter irons will roll backwards after bouncing on the green
(if your shot hits the green on the fly) it’s important to know how far you should try to hit
shots with these clubs into the green. Instead of trying to go exactly to the pin, it’s proba-
bly better to hit the ball just past the hole and rely on the backspin to roll the ball back
close to the hole. 

IMPORTANT: Be very careful in using this strategy if the pin is placed at the back of the
green (check the pin placement with the Overhead View if you can’t remember where the
pin is). Your shot might fly exactly the distance you wanted, but land on the fringe (or worse).
If it does land off the green it will NOT roll back toward the hole (the other surfaces remove
the backspin from the ball).

Fringe Putting (F9)

If you land on the fringe of the green, PGA TOUR Golf assumes that you want to putt from
the fringe and auto-selects your putter. Sometimes the hole will be too far away to putt and
you might want to chip the ball. If you choose a different club for this shot, and then change
your mind, select Fringe Putt from Special Shots in the Options menu to get your putter back.

Make sure you take a look at the Grid View of the green prior to making your Fringe Putt.
The fringe is not as low-cut or smooth as the green so you’ll have to putt the ball a little
harder. The more fringe between you and the green — the more over the listed distance
you’ll need to hit your putt. Don’t shor t-arm your putt.
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Tips On Putting

Ok, you made it the green in good shape. Unfortunately, for a lot of us, this is when the
heartache begins. The number of things that can go wrong in such a small place is almost
beyond belief. But, as experienced hackers, we believe!

Using the Putting Grid

The pros spend years learning to “read” greens. PGA TOUR Golf gives you a hand by pro-
viding a grid view of the green that will help read its contours. Once the grid is displayed,
use the F1 and F2 keys to rotate the grid. Press the F1 key 4 times and you’ll be right
behind your ball with a straight look at the hole. Note the elevation (above or below)
between the ball and the cup as well as the distance. This information is printed above the
Grid View. You may find that the grid is the best place to aim your putt. Use the arrow keys
to align your ball with the aiming cursor. All aiming you do on the grid will be carried back
to the normal view when you return to the green.

Putting and the Stroke Bar

Make sure that the distance your ball needs to travel to get to the hole (shown in the Info
Box) is encompassed by the distance at the end of the Stroke Bar. Change the distance
potential so that you can hit most of your putts near the 100% mark. You can change the
distance potential of your putter with the mouse (click the left mouse button in the Info
Box), or with the up- and down- arrows from your keyboard.

The Notorious 5-foot putt is not a Gimme––even to the Pros!

If the computer selects the 5-foot distance potential for your putt, the contours on Grid View
should not come in to play unless the slope is very severe. Hit your putt as close to the
100% mark as possible regardless of the distance between you and the hole. You’ll make
more shor t putts this way (and perhaps decrease the level of your frustration).

Practice Makes Perfect

No one can just walk out on the PGA TOUR and putt as well as the best in the World. Use
the Putting Green(s) on all the courses to familiarize yourself with how to read the Grid View
as well as how hard to hit your putts given their distance and topography.

Good luck, and good golfing!
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MENUS

PRO SHOP & THE PGA TOUR TENT

Here’s where you make most of your selections. (Keyboard commands are shown in paren-
theses.) Whenever you star t PGA TOUR Golf, you begin each play session at the Pro Shop.
During Tournament play, you’ll return to the hospitality tent (rather than the Pro Shop) when
you leave the course.,

PLAY MENU (P)

The Play menu lists all the game play modes.

Practice Round (P)

Lets you practice a round of golf on any of the PGA TOUR Golf courses. You’ll be prompted
to make the following selections. 

1. Select Number of Players.

2. Specify Human or Computer Players.

The rest of these selections are repeated for each human player.

3. New or Old Player — Enter a new name or select a player you’ve previously saved
to disk.

4. Professional or Amateur Tees — Pro tees are far ther from the pin than amateur
tees. In Tournament play professional tees are selected automatically.

5. Select Clubs — PGA rules strictly enforce a14 club rule, so play to your strengths.
If you really want to take that 5-wood, one of your irons will have to stay at the
Pro Shop. The clubs your caddy has loaded into your bag are marked with an
asterisk. If you want to make some changes, highlight a club you can do without
and click Remove (or press R on the keyboard). Then highlight a club you want in
your bag and click Take or press T). An asterisk will appear next to that club to
show that it’s clean, in your bag, and ready to perform miracles.

6. Select the course you want to play.

During a practice round, you can select any option except those associated with tournament
play, like the Leader Board and Tournament Results.
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Tournament (T)

Starts a PGA TOUR tournament. You make the same selections as for a practice round,
except you must play from the professional tees.

During a tournament, you can select any menu option except those associated with prac-
tice. You must play the holes in sequential order, and no mulligans are allowed.

Driving Range (D)

Takes you to the driving range of the current golf course. To go to a different course, choose
New Course from the Go To menu. [The Go To menu title appears only when you are on the
Driving Range, Putting Green, or playing one of the courses].

Putting Green (G)

Takes you to a random spot on the green of a random hole on the current course. As you
sink putts, you’re taken to random places on the green of that hole. To go to a different
hole, select Hole from the Go To menu and make your choice. To go to a different course,
choose New Course from the Go To menu. [The Go To menu title appears only when you are
on the Driving Range, Putting Green, or playing one of the courses].

Resume Game (R)

Takes you back to whatever you were doing before you returned to the Pro Shop or the TOUR
Tent from any of the other Play modes.

Quit (Q)

Exits to DOS. You’ll be asked if you want to save your game before exiting. You can only
save one game at a time.

FILE MENU (F)

The File menu lists all the disk options.

Save Game (S)

Saves your current status in a tournament or a practice round. You can only have one saved
game at a time. Please note that the game will attempt to save to your copy of the Program
Disk.

Restore Game (R)

Loads your last saved game, either a tournament or practice round.
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Delete Player (D)

Deletes a saved player from the disk.

VIEW MENU (V)

The View menu lists all your score displays.

Scorecard (S)

Your scorecard for the current game. Press the spacebar (mouse button, or joystick button)
to return to the golf course.

Leader Board (L)

Displays the leader board for the current tournament. Press Enter to advance through the
pages of the board more quickly than the game presents them. Press the spacebar to
return to the golf course.

Tourney Results (T)

Displays the results of a tournament as soon as the last player holes his putt on 18. Each
page is shown for a few seconds before the next is displayed. Press Enter to advance
through the pages of the board more quickly than the game presents them. Press the
spacebar (mouse button, or joystick button) to return to the Pro Shop.

STATS MENU (S)

The Stats menu lists all the performance statistics available in PGA TOUR Golf.

Current Players

This shows the lifetime statistics for any player playing the current tournament or practice
round.

Longest Drive (yards).
Driving Accuracy (%) in fairway.
Greens in Regulation (%) — the percentage of greens reached at least two strokes under par.
Putts/G.I.R. (#) — putting average based on the number of putts hit on greens reached in
regulation.
Par Breakers (%) — the percentage of holes where the player beat par.
Tournaments Won (#)
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Earnings ($)
Average Score (#)
Best 18 holes (#)

Saved Players (S)

Shows the lifetime statistics for any player saved on disk, as listed above in Current
Players.

Tournament (T)

Shows the tournament earnings for all players. Press Enter [or the left mouse button or but-
ton one on your joystick] to page ahead to see the Leading Scorers. Press spacebar [or the
right mouse button or button two on your joystick] to return to the course.

Leading Money Winners
Earnings ($) — total money won.
Won (#) — tournaments won.
Top 10 (#) — tournaments finished in the top 10.
In the Money (#) — tournaments in which the player made the cut into rounds 3 and 4.

Leading Scorers
Average (#) — average lifetime score.
Best 18 (#) — best 18-hole score.
Best 72 (#) — best four-round score.

Reset Pros (R)

Resets the accumulated stats of the pros to zero.

OPTIONS MENU (O)

When you’re at the Pro Shop or in the Tournament Tent, the Options menu displays the
views and sound options that are available for use during your round. Activate (or deacti-
vate) any option by clicking on it (or by pressing the appropriate highlighted letter). An active
option has a check mark in front of it. Auto-views that are activated automatically, can also
be be activated by a keyboard command.

Overhead (auto-view) (O)

After you hit the ball, an aerial view of the current hole, showing the vectors of your shots,
automatically appears.
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Ball Lie (auto-view) (B)

Automatically displays the lie of the ball after every shot you take (except on the green).

Greens (auto-view) (G)

When you land on the green, a contour grid of that green appears automatically. You must
be near or on the green to use keyboard command G to see this grid.

Fly-by-Hole Preview (F)

Offers a bird’s-eye view of the current hole, which shows everything from the pin placement
to the fairway hazards to the tee. Each fly-by on a TPC hole is accompanied by instructive
commentary or helpful advice from one of PGA TOUR Golf’s featured professionals. Only the
fool-hardy will ignore their remarks.

Music (M)

Play music during the fly-by and the introduction.

Sound Effects (E)

Toggle the game’s sound effects on and off. Effects include the sound of the club hitting
the ball, the ball’s bounce, and the ball bottoming out in the cup.

Save Setup (S)

Saves your Options configuration to disk. This setup will be loaded every time you start PGA
TOUR Golf.

ON THE GOLF COURSE

When you‘re out on the course, the menus of PGA TOUR Golf are different than when you’re
at the Pro Shop. You’ll use these new menus to make special selections on the courses,
the driving ranges, and the putting greens. Not all options are available in all places. 

GO TO MENU (G)

The Go To menu lists all the places you can go to as you play PGA TOUR Golf.

Hole (H)  [Not available in Tournament Mode]

Takes you to any hole on the current course.

New Course (N)  [Not available in Tournament Mode]

Takes to any of the four golf courses for a practice round. 27



Pro Shop (P) <or> PGA TOUR Tent (P)

Returns you to the Pro Shop during practice, or takes you to the PGA TOUR tent during a
tournament.

OPTIONS MENU (O)

The Options menu lists special play options.

Special Shots (S) 

See the Strategy Guide for instructions on how to use the three special shots, Chip Shot
(C); Punch Shot (P); and Fringe Putt (F).

Normal (N)

Deactivates the conditions that apply when using special shots.

Take a Mulligan (M)  [Not available in Tournament Mode]

To repeat a shot during a practice round. Mulligans do not count as strokes. Think of them
as a learning experience. You can take multiple mulligans of one shot, or select Take a
Mulligan repeatedly to move back to the tee.

Pick up Ball (P)

Accept a score of 12 strokes for the current hole, and go on to the next hole.

Instant Replay (I)

Show a replay of the last shot.

VIEW MENU (V)

The View menu lists all the special views and score displays. Press the spacebar, a mouse
button, or a joystick button to return to the course.

Ball Lie (B)

Displays your ball lie on the course.

Overhead (O)

Displays the aerial view of the course showing your shots.
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Green (G)

When you’re on or very near the green, this option displays a contour map of that green.

Scorecard (S)

Displays your scorecard for the current game.

Leader Board (L)

Displays the leader board for the tournament.

Tourney Results (T)

Displays the results for the tournament just after it’s over.

Hot Keys (H)

Displays shor tcut commands for some of the more common and useful selections.

F1 Instant Replay F6 Scorecard
F2 Mulligan F7 Chip Shot
F3 Ball Lie F8 Punch Shot
F4 Green F9 Fringe Putt
F5 Overhead F10 Normal Shot

STATS MENU (S)

The Stats menu lists the performance statistics for all current players.

Current Players (By Name)

Displays the lifetime statistics for any player playing the current tournament or practice
round. See Current Players on page 25

Tournament (T)

Displays the tournament statistics for all players: first, the Leading Money Winners, first,
and then for the Leading Scorers. See page 26
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PGA TOUR® GOLF GUIDE

A BRIEF HISTORY OF THE PGA TOUR

The exact beginning of professional golf in America is difficult to discover. The names of the
best golfers from the early 1800s are for the most part lost to us. Unfortunately, what they
did, who they played against, what they played for, and sometimes even where they played
is shrouded in the mystery of time past. But that there were professionals dedicated to the
game, and fans who thrilled to outstanding play, no one doubts. 

Beginning in 1898, the historical record starts to yield more concrete information. The dis-
tinguished history of professional golf begins to emerge on New Year’s Day of that year. In
the middle of winter, ten professional golfers played 36 holes of stroke play at the Ocean
County Hunt and Country Club in Lakewood, New Jersey and competed for a total purse of
$150. The winner, Val Fitzjohn, defeated his brother in a sudden-death playoff and took
home $75.

Despite the weather, a large gallery came to witness the event, and the New York Times
provided extensive coverage of the tournament. Shortly thereafter, tournaments began to
pop up across the country. But this was not “tour” golf, as we know it today, because the
events lacked continuity. Interest in the game, however, continued to grow. American pro-
fessionals were rapidly improving their games and crowds were becoming more knowl-
edgeable. When John McDermott became the first native-born to win the U.S. Open (1911),
enthusiasm for the game expanded exponentially.

Helping this growth was a commercially-backed exhibition “tour” by Englishmen Harry
Vardon and Ted Ray. The two travelled across the country and attracted huge crowds when-
ever they stopped to play during the summer of 1913. However, the biggest explosion of
interest in the game occurred that September. A 20-year old “local boy,” Francis Ouimet,
defeated the pair in a playoff for the United States Open Championship at Brookline, MA.
Suddenly, golf became front page news and a game for everyone.

The early Twenties saw the first development of what we know as the PGA TOUR. In the win-
ter, tournaments were held on the West Coast, Texas and Florida. By the middle of the
decade, the TOUR was offering $77,000 in total purses and donating a substantial amount
of money to charity. Names like Walter Hagen, Gene Sarazen and Bobby Jones became folk
legends in a nation hungry for heroes.

In the Thirties, the TOUR continued to grow. The PGA of America provided support to the
fledgling tour and despite the financial woes caused by the Great Depression, golf tourna-32



ments were able to attract large crowds. It is interesting to look back at some figures of
the time. Paul Runyan was the leading money winner of 1934 with $6,767. In contrast, in
1989, the top two money winners — Tom Kite and Payne Stewart — each earned over $1
million (see PGA Facts and Figures, The Growth of Tour Purses, below for more information).

Like other outstanding professional athletes of the era, the names of the TOUR’s best
golfers became household words in the late 1930’s. By the early 1940’s Sam Snead’s
name started to appear in the headlines with regularity. Then came Ben Hogan, Byron
Nelson, Jimmy Demaret and others who were to gain nationwide fame.

Following World War II, the TOUR became more structured and as TVs appeared in more
and more of the nation’s homes in the late 50s and early 60s, interest in the game explod-
ed. Once television became a player in the game, the eyes of the world were on golf. The
exposure inspired millions to try the game and at the same time, TV-advertising revenues
sent purses soaring. The bulk of these revenues, which are distributed by the PGA TOUR to
all co-sponsors, have gone back into the purses, accounting for the tripling of prize money
in the last decade alone.

During Commissioner Deane Beman’s administration, which began in 1974, the value of
tournament purses has escalated at an unprecedented rate. PGA TOUR assets have grown
from $730,000 in 1974 to $80 million today, and total revenues have increased from $3.9
million to $140 million in the same time period. This tremendous growth in revenues has
created a number of wealthy athletes, but more importantly it has allowed the PGA TOUR
to vigorously pursue its goal of being a major contributor to charitable causes.

Charitable donations have been a hallmark of professional golf almost from the very begin-
ning. The idea of turning over a tournament’s after-expenses profits to charity has its origin
in 1917. During World War I, a professional tournament was played to raise funds for the
Red Cross. Likewise, numerous exhibitions were staged for the same purpose. These prac-
tices set the mold for the TOUR and since 1938, PGA TOUR events have donated $145 mil-
lion dollars to charity. Each of the last 13 years have seen charitable contributions increase
dramatically, to the point where over $100 million has been donated since 1984. The slo-
gan, “The leading money winner on the PGA TOUR is Charity,” is definitely not just a catch
phrase.

Great athletes, knowledgeable fans, progressive and inventive administration, and corpo-
rate involvement have made PGA golf the great game it is today.

— adapted from the Official 1990 PGA TOUR Media Guide 33



PGA FACTS AND FIGURES

Golfers and fans from every level of the game have a long-standing love affair with the sta-
tistics of golf. After all is said and done, the numbers tell us who won, and who didn’t do
as well. Though the game is played in tranquil settings, in reverent silence, this calm is
often belied by the frantic excitement caused by the large prizes that are at stake. The pro-
fessionals naturally feel the “heat” a bit more acutely than we do. That doesn’t keep us
from living and dying with our favorite’s next shot.

What follows are three different kinds of statistics that we thought you would enjoy. They
are all a part of the fascinating texture of the PGA TOUR.

GROWTH OF TOUR PURSES: A SIX-FOLD INCREASE IN THE LAST TWENTY YEARS

Year No. of Events Total Purse

1970 55 $ 6,751,523
1971 63 7,116,000
1972 71 7,596,749
1973 75 8,657,225
1974 57 8,165,941
1975 51 7,895,450
1976 49 9,157,522
1977 48 9,688,977
1978 48 10,337,332
1979 46 12,801,200
1980 45 13,371,786
1981 45 14,175,393
1982 46 15,089,576
1983 45 17,588,242
1984 46 21,251,382
1985 47 25,290,526
1986 46 25,442,242
1987 46 32,106,093
1988 47 36,959,307
1989 44 41,288,787
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PRIZE MONEY DISTRIBUTION 

To finish a tournament “in the money” is every professional’s goal when he starts his first
round on Thursday morning. If he makes the 36-hole-cut, he accomplishes his goal and has
a chance for a really big payday. How much a golfer can make in a given tournament
depends entirely on the total purse being offered by the tournament sponsors. Below are
some examples of what the PGA TOUR pros are playing for when they tee it up on Saturday
and Sunday.

Total Purse: $600,000 (The Southern Open, Green Island Country Club, Columbus, GA)

Position 1 2 3 4 5

Prize $108,000 64,800 40,800 28,800 24,000

Total Purse: $1,000,000 (Federal Express St. Jude Classic, TPC at Southwind,
Germantown, TN)

Position 1 2 3 4 5

Prize $180,000 108,000 68,000 48,000 40,000

Total Purse: $1,500,000 (THE PLAYERS CHAMPIONSHIP, TPC at Sawgrass, Ponte Vedra, FL)

Position 1 2 3 4 5

Prize $270,000 162,200 102,200 72,000 60,000

1989 PGA TOUR STATISTICAL HIGHS/LOWS

Those with 50 rounds or more based on 186 ranked players.

Statistical Category Highest Average Lowest

Driving Distance 280.9 261.8 245.5
Driving Accuracy .826 .650 .479
Greens in Regulation .726 .655 .535
Putting 1.734 1.787 1.878
Par Breakers .224 .183 .148
Eagles 14 4 0
Birdies 415 268 137
Scoring Average 69.49 71.08 72.92
Sand Saves .660 .505 .361
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“10 of the best” in PGA TOUR Golf

As you play the challenging TPC courses in the game, ten of the PGA TOUR’s most out-
standing professionals offer their insights and advice to help you along. You’ll get the ben-
efit of their experience and perhaps take inspiration from their success. Consistency and
competitiveness are the hallmarks of these featured professionals. Learn from their expe-
riences and let them guide your play through the exhilarating TPC courses.

TOMMY ARMOUR III

Owner of one of the most revered names in the distinguished history of golf, Tommy is the
grandson of the “Silver Scot,” winner of the U.S. and British Opens, the PGA Championship,
and char ter inductee to the PGA Hall of Fame (Palm Beach Gardens, Florida).

Despite his lineage, a career in golf was not automatic for Tommy (III). He was a fine school-
boy athlete, who excelled in several sports. It was at first with regret that he had to choose
between golf and baseball, because they shared the same season. By the time he finished
high school, however, the regrets were gone. The decision to dedicate himself to golf intro-
duced a new sense of purpose and commitment to his life.

Following a remarkably successful amateur career, topped off by winning the William Tucker
Intercollegiate event while at the University of New Mexico, Tommy qualified for the TOUR
in 1981, when he was 21. He now thinks of this as a kind of “false” start in his chosen
career. 1982 was not what he hoped it would be. For the next five years he tried to get his
card back, and each year he just barely missed.

Naturally, Tommy was disappointed. But he was undaunted. He used his time off the PGA
TOUR to good advantage. He gained precious experience by practicing hard and playing
competitively in several events on the European and Asian Tours. His perseverance and
dedication have paid off handsomely. Since he regained his card at the PGA TOUR’s
Qualifying Tournament in 1987, his “real” career has taken off brilliantly.

In 1988 he finished 66th on the prize money list, and in 1989 he tied for runner-up in the
Kemper Open at the challenging Tournament Players Club [TPC] at Avenel. He completed
the year ranked in the top twenty in three statistical categories: greens in regulation,
birdies, and eagles. When Tommy talks golf shots, people listen.

The future looks bright for this descendant of one of golf’s great families.
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PAUL AZINGER

New England born and raised, Paul honed his game with collegiate experience and great
coaching at Brevard Junior College and Florida State University. Following an unheralded
entry to the PGA TOUR in 1982, and a couple of undistinguished (though not unproductive)
years, Paul began a meteoric rise to the highest levels of the game in 1985. Some would
call that rise an assault. Paul took no prisoners. He simply improved every aspect of his
game including his competitiveness, and his efforts were recognized in 1987, when he was
named PGA Player-of-the-Year.

No one doubted that this honor was well-deserved. Paul won three tournaments that year
and had led the TOUR in Sand Saves in 1986 and 1987. His earnings for 1987 exceeded
his 1986 take by over half a million dollars–– the fifth largest one-year increase in PGA
TOUR history. 

While never terribly long off the tee, Paul is always among the TOUR leaders in hitting
greens in regulation. His uncanny ability to select just the right club has positioned him con-
sistently high among the Par Breakers, and in 1989 he was ranked best all-around golfer
on the TOUR. His amazing 69.69 scoring average is the envy of all his peers. Consistency
and shot-making ability made him an obvious choice for the Ryder Cup team to which he
was named in 1989.

Paul’s boyish good looks, lanky frame, and pleasantly engaging manner have won him a
loyal and enthusiastic following. But it’s his superlative all-around game which has made
him tremendously popular with galleries and golfing fans everywhere. His even disposition
and ever-improving consistency foretell even greater accomplishments for this fine com-
petitor.

As 1990 began Paul held 10th position in the Sony World rankings, which compares play-
er per formances around the world.
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FRED COUPLES

A fine all-around athlete, Fred was encouraged by his father to begin competing in junior golf
events in his native Seattle. The young man loved the game and demonstrated his skill and
commitment by becoming an All-American at the University of Houston in 1978 and 1979.
After qualifying for the TOUR in 1980, he showed that he was equal to the challenge of pro-
fessional competition by becoming the leading money winner among rookies in 1981.

By 1983 seasoned professionals and golf fans everywhere were discovering that Fred has
as much talent as anybody on the TOUR. He is consistently ranked in the top 15 profes-
sionals in scoring, eagles, putting, and driving distance. And, if “pressure” could be a mid-
dle name, it would be his. Like all great TOUR competitors, Fred thrives on playing under
pressure.

At the 1983 Kemper Open, Fred calmly won the now famous 5-player sudden- death play-
off. In 1984, after shooting a record-tying 64 in the first round of THE PLAYERS CHAMPI-
ONSHIP (TPC at Sawgrass), where every shot must be precise, Fred never looked back.
Even though Tom Watson, Seve Ballesteros, and Lee Trevino mounted furious challenges
to his leadership, Fred came away with the victory––by one stroke!

Great shot-making ability and immunity from pressure: what a winning combination! It came
as no surprise that Fred was ranked number two in the 1989 all-around ratings of players
on the TOUR (right behind Paul Azinger) and was also named to the Ryder Cup team.

As 1990 began he held 15th position in the Sony World rankings, which compares player
performances around the world.
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BRUCE LIETZKE

When Bruce was just a small boy in Kansas, his older brother, a course professional in
Wichita, gave him a set of cut-down clubs. Gifts from admired older brothers being at least
equivalent to diamonds in value, Bruce and the clubs were inseparable. And the boy just
didn’t haul them around: he tried to master his brother’s game, at all times, in all weather.
He became a fine high school player, and while on scholarship to the University of Houston,
won the Texas State Amateur title in 1971.

Ironically, Bruce’s early start in the game led him to give it up. Shortly after he left Houston
in 1973, Bruce felt he had played so much golf that he had nothing left to give back to the
game. He put his clubs away for six months and pondered his goals and ambitions. Not sur-
prisingly it turned out that becoming a successful professional golfer was at the top of his
list. With his priorities reordered and his enthusiasm revived, he qualified for the PGA TOUR
in the spring of 1975. 

He played well on TOUR almost from the start, although his first victory didn’t come until
1977. But then the floodgates were opened and Bruce’s sparkling play made him an easy
selection for the Ryder Cup (1981) and allowed him to finish in the top twenty of the money
list for the next several years. He reasserted his exacting game in 1988, winning the GTE
Byron Nelson Classic at the TPC at Las Colinas. In 1989 he nearly tamed the TPC at
Sawgrass in THE PLAYERS CHAMPIONSHIP before tying for third. 

Once again in 1989 Bruce had the best percentage among active professionals for hitting
greens in regulation (73%). His accuracy with the driver is almost unmatched, so the mes-
sage is clear: When Bruce is playing well, the rest of the field better turn it up a notch.

39



MARK MCCUMBER

The past four years (1986-1989) have seen Mark solidify his position as one of the finest
players in the game. He finished 1986 ranked 80th on the money list, with three TOUR vic-
tories to show since he qualified for his card in 1978. 1987 opened a new chapter in his
professional life as a player. He won the Anheuser-Busch Classic and followed that victory
with an awe-inspiring triumph at the THE PLAYERS CHAMPIONSHIP (TPC at Sawgrass) shoot-
ing a record-breaking 273 (15 under par). In addition to walking away with the first prize
check, mark received a 10-year TOUR exemption for his stunning victory.

Mark continued his winning ways in 1989. In addition to winning the Beatrice Western Open
and tying for second at the U.S. Open, he had five other top 10 finishes. This amazing per-
formance placed him 14th on the money list and insured his selection to the Ryder Cup
team. As 1990 began he held 18th position in the Sony World rankings, which compares
player per formances around the world.

Considering his consistently fine performance at the THE PLAYERS CHAMPIONSHIP (TPC at
Sawgrass) it’s no surprise that Mark and his family make their home in Ponte Vedra, Florida.
“Live where the luck is,” as they say. But Mark may have another reason for living nearby
the Tournament Players Club at Sawgrass: it gives him an opportunity to study and learn
the lessons of one of the most beautiful and challenging courses in the U.S. This is appro-
priate because when Mark puts on his other hat, he’s among the best of the new genera-
tion of golf course architects.

Mark and his brothers have founded a firm specializing in golf course design. Several of
their courses have already been built and have received high praise. As a designer, Mark
has the potential of having a greater impact on the world of golf than he has as a player.
And considering his excellent golf game, that would be some impact, indeed.
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LARRY MIZE

As a complement to his superbly consistent game (of 25 tournaments entered in 1989, he
finished 22 of them in the money) and in recognition of his valuable off-course contributions
to the game, Larry was elected by his fellow professionals as a Player Director of the PGA
Tournament Policy Board. The Board establishes the goals and policies of the PGA TOUR.
It is a tribute to his concentration and dedication that Larry has been able to fulfill both his
playing and administrative responsibilities with flying colors.

When Larry was nine years old, living in Augusta, Georgia, his father––a scratch handicap-
per––taught him the game. That early training served him well. He had a fine collegiate
career at Georgia Tech in Atlanta, and qualified for the TOUR in 1981. Six years later he
returned to Augusta to win the Master’s Tournament (1987) with one of the most thrilling
shots in recent memory.

After dropping an 8-foot birdie putt on 18 to force a tie with Greg Norman and Seve
Ballesteros, Larry birdied the second playoff hole ( No. 11 at Augusta National) by holing
out with a 140-foot chip shot. The appreciative crowd erupted with applause appropriate to
such ar tistry. Norman later missed his putt for birdie and the victory was Larry’s. This, as
it happened, was tit for tat, because Greg had beaten Larry on the sixth hole of a fiercely
contested playoff at the Kemper Open (TPC at Avenel) in 1986.

Larry’s middle name is Hogan. Given his father‘s love of the game, is it possible that Larry
has a namesake from the world of golf? Given the honored name, is Larry destined for even
greater things on the golf course? You can bet on it!

As 1990 began Larry held 19th position in the Sony World rankings, which compares play-
er per formances around the world.
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MARK O’MEARA

Mark started to play the game seriously as a teenager in Mission Viejo, California. His
progress was rapid and his skill sufficient to win him a place on his high school team.
Dedication and constant improvement won him a scholarship at Long Beach State, where
he became an All-American in 1979. His amateur career culminated in his victory over John
Cook in the 1979 United States Amateur Championship.

With his professional career off to a running start, Mark fulfilled his boyhood dream and
qualified for the PGA TOUR in 1980. Predictably, his work habits and his talent impressed
everyone. He was named TOUR Rookie-of-the-Year in 1981. Although it took him a couple
of years to break away from the pack, Mark showed in 1984 that he was destined to
become a great player.

In 1984 he finished second on the money list, putting together an almost unequaled record
of top three finishes (9) and forged a well-deserved reputation for consistency and tough-
ness that lasts to this day. His performance led to his being named to the Ryder Cup team
in 1985. This was no flash in the pan. It was real gold. Mark was named to the Ryder Cup
Team a second time in 1989 following a great year in which he ranked 13th on the money
list.

Mark has always been known by his peers as a great putter, a superb tough-course player,
and an avid student of all facets of the game. As if to prove his colleagues right, Mark was
ranked 13th among PGA pros in putting in 1989; won (for the second time) the always dif-
ficult Pebble Beach National Pro-Am; and won the respect of golf course architects with his
perceptive and inventive advice on course design.
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JOEY SINDELAR

Like so many of the fine players on the PGA TOUR, Joey learned the game at his father’s
elbow. He was six years old when he first picked up a club, and the game has continued as
a passion to this day. Likewise, his father’s involvement in his professional life has
remained a constant. Joey’s dad is his coach, mentor, sounding board, advisor, and source
of inspiration. With characteristic, though perhaps too much modesty, Joey says “Dad’s
been behind everything I’ve done.”

Joey improved his game in high school and won the New York State Junior Tournament in
1972. He had realized by then that he would need a scholarship if he was to continue his
education. Colleges came running for his talents and he decided on Ohio State University,
following in the footsteps of Jack Nicklaus and Ed Sneed. Joey honored his famous prede-
cessors and the OSU program by being named All-American three consecutive years.

After receiving his B.S. in 1981, Joey turned professional and qualified for the PGA TOUR
in 1983. From the star t he played like a champion. Many of his peers think Joey plays the
long courses as well as anyone. He is consistently among the TOUR leaders in Distance
Driving and Par Breakers.

Following a spectacular year in 1988, including two TOUR victories, Joey was named to the
Kirin Cup team. His earnings that year gave him sole title to the fourth largest single-sea-
son earnings gain in TOUR history (over half a million dollars). It’s fair to suspect that he
used some of that hard earned money to indulge his habit of collecting antique golf equip-
ment. With Joey’s explosive game it’s likely that some of his fellow pros often find them-
selves wishing, if only in jest, that he’d bronze his own clubs.
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CRAIG STADLER

With a current total of eight TOUR victories, a bushel basket full of top ten finishes, and the
ungrudging respect of his peers, Craig Stadler is unlikely to sneak up on anybody in 1990.
He has proven his mettle. But Craig’s amateur and early professional history is an instruc-
tive example of how difficult it is for even a great golfer to rise to the top of his profession,
and how truly competitive the PGA TOUR has become.

If anyone ever looked like a “sure thing” entering the TOUR in 1976, it was Craig. His cre-
dentials were impeccable. California born and raised, he started playing the game year-
round with his dad, at the age of five. At eighteen, he won the World Junior Championship
(1971). In 1973 he became United States Amateur champion. Unanimously selected as an
All-American at the University of Southern California (USC) in 1974 and 1975, he was
named to the Walker Cup in 1975. And then he qualified for the TOUR. 

Strange to say, four years of completely unexpected mediocrity followed. He wasn’t playing
badly; he just was not excelling. There were too many good players in front of him. But in
1980 his star began to shine, with two PGA TOUR victories. “Cream rises,” as they say.
Does it ever! Craig won the Kemper Open in 1981. In 1982 he notched four more victories,
including the Master’s and his second Kemper title and finished the year by winning the
Arnold Palmer Award as the leading money winner on the TOUR. The star had become a
supernova, and although he’s had to work through a few low energy cycles, he’s still burn-
ing brightly in 1989.

After monopolizing the title of TOUR’s champion Par Breaker in 1984, 1985, and 1986,
Craig is currently ranked number 5 in that critical category. Of the twenty-two tournaments
he entered in 1989, he finished in the money twenty-one times. It’s clear to all his peers
and the informed golfing public that one nickname should replace all the color ful monikers
that have been suggested by Craig’s unique physique: just call him “Winner.” 
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FUZZY ZOELLER

When talk turns to the great professionals playing today, Fuzzy Zoeller‘s name always
comes up. And rightfully so. A United States Open Championship crown (1984) and a
Master’s Tournament title (1979) are enough to insure his place in history. But to hear peo-
ple talk, one might think that Fuzzy’s middle name was “Potential,” so often is that word
connected to the New Albany, Indiana native.

Discussing “what might have been” is usually a futile and aggravating exercise. But in
Fuzzy’s case it’s understandable. From the time he qualified for the TOUR (1974) until he
had par tially corrective back surgery (1985), pain, resulting from a high-school basketball
injury, was a constant companion. No one doubts that pain affects performance. He won
seven events on the TOUR before 1985. In the first year after his surgery, he won three
events. Draw your own conclusions.

Fuzzy has never used his health as an excuse. He plays when he is able, and doesn’t play
when he thinks he can’t per form up to his exacting standards. In fact, his overall play has
been outstanding, and he has been an obvious choice for the Ryder Cup team on three
occasions (1979, 1983, 1985). Many people “in the know” believe that if Fuzzy is in con-
tention on Sunday, he will, more often than not, win the tournament. His stylish game com-
bined with an open and winning personality have made him a gallery favorite, and his fel-
low professionals have admired and loved him for more than a decade. 

While he currently ranks among the PGA leaders in hitting greens in regulation, par break-
ing, and scoring average, most professionals think the strongest part of Fuzzy’s game is
his remarkable ability to make a difficult shot under tremendous pressure. He used this
capability at the awe-inspiring PGA West (TPC at La Quinta) where he won The Skins Game
against great competition in 1986.
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TOURNAMENT PLAYERS CLUBS [TPC]

Among the many exciting and original concepts developed by the PGA TOUR in the past
decade, nothing has affected the millions of golf spectators as much as the invention and
construction of the Tournament Players Clubs [TPC]. The TOUR believed that over the years
the interests of spectators had often been ignored or sacrificed for other important con-
cerns when golf courses were designed. The PGA TOUR determined that when it got the
opportunity to build its own, it would construct courses that not only challenged the play-
ers, but allowed spectators an unprecedented, unimpeded look at the action. This dream
was realized in 1980 with the construction of the TPC at Sawgrass. And in less than ten
years the dream has grown into a network that now encompasses 21 TPCs in 12 states
and, with the addition of TPC International courses in Japan, two countries.

The TPC courses are sometimes referred to as Stadium courses, because many of the
greens are designed like amphitheaters. All over the courses one finds spectator mounds
that afford fans unrestricted views of the tees, fairways, and greens. In fact, the 18th hole
at the original TPC at Sawgrass can accommodate more than 40,000 people––all have a
clear view of the action. You won’t see any periscopes at an event on a Tournament Players
Club course!

All TPCs are designed to host PGA TOUR or Senior PGA TOUR events and to date the cours-
es have been designed by some of the top architects in the business––Pete Dye, Arthur
Hills, and Ed Ault Associates, just to name a few. In addition to securing the services of
topflight designers and architects, the PGA TOUR often assigns a TOUR player to act as a
consultant to the designer, in the hopes that his special expertise and point of view will add
a bit of spice to the project.

Since the Tournament Players Club at Sawgrass opened, the TPC network has now truly
become the “best set of clubs” in America. This has been a great benefit to the entire golf-
ing public as well as the PGA TOUR players. When you join a TPC club in your area, it’s like
joining a nationwide country club. Memebership at one TPC club allows you to play at any
of the other clubs across the country and an opportunity to view the greatest players in the
world in action on your own course once a year.
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Domestic Tournament Players Clubs

Club Architect Consultant Hosts

TPC at Sawgrass Pete Dye THE PLAYERS
Ponte Vedra,FL CHAMPIONSHIP

TPC at Eagle Trace Arthur Hills Honda Classic
Coral Springs, FL

TPC of Connecticut Pete Dye Howard Twitty Canon Greater
Cromwell, CT Hartford Open

TPC at Prestancia Ron Garl Mike Souchak Chrysler Cup
Sarasota, FL

TPC at Avenel Ed Ault Ed Sneed Kemper Open
Potomac, MD Associates

TPC at StarPass Bob Cupp Craig Stadler Northern Telecom
Tucson, AZ Tucson Open

TPC at Scottsdale Jay Morrish/ Jim Colber t/ Phoenix Open 
Scottsdale, AZ Tom Weiskopf Howard Twitty

TPC at Piper Glen Arnold Palmer PaineWebber
Charlotte, NC Invitational

TPC at Southwind Ron Prichard Hubert Green/ Federal Express
Memphis, TN Fuzzy Zoeller St. Jude Classic

TOURNAMENT PLAYERS COURSES (Licensed Facilities)

TPC at The Woodlands Von Hagge/ Independent
The Woodlands, TX Bruce Devlin Insurance Agent Open

TPC at Las Colinas Jay Morrish Ben Crenshaw/ GTE Byron
Irving, TX Byron Nelson Nelson Classic

TPC at PGA West Pete Dye The Skins Game
La Quinta, CA
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FUTURE TPCs (Announced, Planned and Under Construction)

Club Architect Consultant Hosts

TPC at Snoqualmie Falls Rees Jones Don January/ To Be Announced
King County, WA Peter Jacobsen

TPC at Ventura County To Be Corey Pavin To Be Announced
Simi Valley, CA Announced

TPC of Michigan Jack Nicklaus Mazda Senior
Dearborn, MI Tournament Players

Championship

TPC at Summerlin PGA TOUR Design Fuzzy Zoeller Las Vegas
Las Vegas, NV Services, Inc. Invitational

TPC at Ka’upulehu Jack Nicklaus To Be Announced
Kona, HI
TPC at Cheval PGA TOUR Design Chi Chi Rodriguez GTE Suncoast

Tampa, FL Services, Inc. Classic

TPC INTERNATIONAL

TPC of Kijima TPC of Batoh TPC of Ichihara 
(Japan) (Japan) (Japan)

COURSES AND TOURNAMENTS IN PGA TOUR GOLF

Tournament Players Club [TPC] at Sawgrass, Ponte Vedra, Florida

The TPC at Sawgrass was the first Stadium Golf course to be constructed. From the outset
it was destined to be a special course. The PGA TOUR, looking for a permanent site for THE
PLAYERS CHAMPIONSHIP and wanting to establish a “home club” for the members of the
TOUR, saw greatness in the lush tropical setting near Jacksonville, and the TOUR was
thrilled.

The famous (some say notorious) Pete Dye was chosen as the designer. His mission was
to build a course that would challenge the players and at the same time provide lots of48



spectator amenities, including a variety of unobstructed views of the golfing action. To say
that Dye succeeded admirably is almost an understatement. The nail-biting, pressure-
packed precision required by almost every shot is offset per fectly by the spacious sereni-
ty of the course. And the fans can see it all!

Three of this TPCs’ first nine holes are judged to be among the 100 hardest holes in
America. The treacherous 17th green is surrounded by water. Its bold and original design
has served as a model and inspiration for many of the new breed of course architects. And
when the huge amphitheater circumscribing the 18th green is packed with an appreciative
gallery, every TOUR professional wants to play his very best on this final hole.

No detail was overlooked at Sawgrass. The 6,857 yards of the course are beautifully inte-
grated into the natural terrain rather than being imposed on it. The thoughtful combination
of water hazards and wide sand bunkers introduces a challenge to every player. Even the
extensive practice facilities are beautifully designed.

TPC at Sawgrass is a perfect location for THE PLAYERS CHAMPIONSHIP. Every year the 144
best players in the world pit their skills against the course and golfing fans around the world
have been thrilled by the outstanding performance of several PGA TOUR professionals.
Among the most memorable feats were Fred Couples’ astonishing 64 (8 under) in the first
round of the 1984 tournament; Sandy Lyle’s exciting playoff victory in 1987; and Mark
McCumber’s incredible record-setting victory round of 273 in 1988.

TOURNAMENT PLAYERS CHAMPIONSHIP

Year Winner Score Location Par/Yards

1982 Jerry Pate 280 TPC at Sawgrass 72/6857
1983 Hal Sutton 283 TPC at Sawgrass 72/6857
1984 Fred Couples 277 TPC at Sawgrass 72/6857
1985 Calvin Peete 274 TPC at Sawgrass 72/6857
1986 John Mahaffey 275 TPC at Sawgrass 72/6857
1987 Sandy Lyle* 274 TPC at Sawgrass 72/6857

THE PLAYERS CHAMPIONSHIP

1988 Mark McCumber 273 TPC at Sawgrass 72/6857
1989 Tom Kite 279 TPC at Sawgrass 72/6857
* = Playoff
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Tournament Players Club [TPC] at Avenel, Potomac Maryland

In typical TPC fashion, the layout of the course at Avenel, with its natural amphitheaters and
spectator mounds, offers clear views of all the golfing action. Spectators never have to
strain to see their favorite pros. Definitely a course for the bold player, Avenel like all great
courses, rewards good shots, and penalizes poor ones. The mixed topography of the rolling
Maryland countryside requires a player to take a substantial number of risks to master the
course.

Avenel was designed by Ed Ault Associates and is the home of the Kemper Open, the old-
est continuously corporate-sponsored golf tournament on the PGA TOUR. Kemper National
Insurance Companies hosts this great tournament and can rightfully boast about its pres-
tigious list of participants and past champions including golf greats Craig Stadler, Tom Kite,
and Arnold Palmer, who won the first Kemper Open in 1969. Since its inception, the tour-
nament has given Kemper the opportunity to donate more than one million dollars to local
and national charities.

The course itself is a model of thoroughly diversified design. At almost 7,000 yards in
length, the successful player needs to control every club in his bag to score consistently
well here. Gorgeous elevated tees, a variety of doglegs, tiered greens, rock runs, and water
hazards contribute to the course’s exciting character. The scenic and demanding 9th hole
is typical of Avenel: It’s not long, but features hazards all around the green. The elevated
tee complicates the player’s perspective. Ponds guard the front and right side of the green;
a bunker looms on the left. In short, the course is beautiful but treacherous.

KEMPER OPEN

Year Winner Score Location Par/Yards 

1982 Craig Stadler 275 Congressional CC, Bethesda,MD 72/7173
1983 Fred Couples* 287 Congressional CC, Bethesda,MD 72/7173
1984 Greg Norman 280 Congressional CC, Bethesda,MD 72/7173
1985 Bill Glasson 278 Congressional CC, Bethesda,MD 72/7173
1986 Greg Norman* 277 Congressional CC, Bethesda,MD 72/7173
1987 Tom Kite 270 TPC at Avenel, Potomac,MD 71/6864
1988 Morris Hatalsky 274 TPC at Avenel, Potomac,MD 71/6864
1989 Tom Byrum 268 TPC at Avenel, Potomac,MD 71/6864

* = Playoff50



PGA WEST Stadium Course at La Quinta, California

The TPC Stadium Course at La Quinta was conceived and designed by Pete Dye. It is the
current site of The Skins Game. With a USGA rating of 77.1, the Stadium Course is unani-
mously ranked one of the 100 greatest golf courses in the world. 

Unarguably a major part of the course’s greatness resides in its enormous difficulty. The
faint-hearted simply can’t play here. Its unique collection of swales, valleys, humps, and
mounds give pause to even the most courageous professionals. Numerous intimidating dri-
ving holes with greens guarded by cavernous bunkers and merciless water mean that col-
lars can get pretty tight in the closing rounds of a tournament. 

The fairways are thin ribbons of undulating turf. Sand, pot hole, and even fairway bunkers
make every shot an adventure. The greens, when you can see them, are deep and con-
spiratorial. Like all great courses, the Stadium Course at PGA West makes you take your
best shot every time you step up to the ball. Each shot is make or break. If you try to bail
out, you get burned. If you try to lag up to the water when you should be trying to carry over
it, trouble is guaranteed. 

Each hole carries a descriptive epithet, and the pros know that these are more than nick-
names. The 6th hole called AMEN, is on The PGA of America’s 18 toughest holes in
America. It is in fact held by many to be the toughest hole in existence. The pros are ecsta-
tic when they’ve finished playing it. The signature bunkers of the San Andreas Fault (16)
and Eternity (11) have deprived many golfers of sleep.

All fun aside, the pros and the fans love the TPC Stadium Course at La Quinta. The galleries
get superb views of PGA TOUR members, playing a supremely challenging course at the top
of their games, executing a magnificent variety of almost impossible shots with the preci-
sion and grace that we all love to dream about.

The United States Ryder Cup team is eagerly looking forward to hosting its European com-
petition at PGA West, which has already been selected as the site of 1991 Ryder Cup
matches.
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ARTISTS 

Lee Actor and Dennis Koble formed Sterling Silver Software in 1988 to bring together their
diverse talents for creating entertainment software. The two have programmed for a wide
variety of machines, ranging from coin-operated arcade units to home computers to hand-
held games. With thirty software titles already to their credit, PGA TOUR Golf pushes the
count yet higher.

Lee and Dennis are inveterate golfers, giving local courses the once-over every week or two.
They’d like to tell you they’re scratch golfers, and they are - as long as they’re playing with
the pros in PGA TOUR Golf. As for their real golf game? Well, it seems there’s so much more
they’d rather tell you about the virtues of metal woods.

CREDITS AND ACKNOWLEDGEMENTS FOR PGA TOUR GOLF 

Software Design: Lee Actor and Dennis Koble
Software Programming: Lee Actor and Dennis Koble
Graphics/Animation: Wilfredo Aguilar 
Music/Sound Effects: Nic Tenbroek
Producer: Don Traeger
Associate Producer: Jim Rushing
Assistant Producers: Happy Keller, Jon Horsley
Technical Assistant: Jesse Taylor
Product Manager: Zina Yee
Graphic Ar ts Director: Nancy Fong
Documentation: R.J. Berg and Eric Lindstrom
Artist Photographer: Frank Wing
Cover Photographer: Jim McBride/PGA TOUR

Special Thanks to Greg Minjack, Direct Marketing Manager, PGA TOUR Marketing/
Promotions Depar tment, and Rich Adam for his contributions to game design and testing.

TPC, Tournament Players Club, PGA TOUR, THE PLAYERS CHAMPIONSHIP, The Skins Game,
Stadium Golf, TPC International, and the Senior PGA TOUR are registered treademarks.
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The following player names are used with permission of PGA TOUR:

Paul Azinger J.C. Snead Mark O’Meara Mike Donald
Fuzzy Zoeller Dan Pohl Bruce Lietzke LorenRoberts
Mark McCumber Tom Pur tzer Larry Mize Gene Sauers
Tommy Armour III Kenny Knox Craig Stadler David Frost
Joey Sindelar Jeff Sluman Fred Couples Wayne Grady
Jay Haas Jim Hallet Clarence Rose Andrew Magee
Stan Utley Jim Car ter Larry Rinker Larry Nelson
Brad Faxon Billy Andrade Robert Wrenn Ian Baker-Finch
Mike Reid Lon Hinkle Phil Blackmar Hale Irwin
Dave Barr Howard Twitty Mark Lye Jim Booros
Dave Rummells Doug Tewell Mark Wiebe Robert Lohr
Peter Jacobsen Hal Sutton Ed Fiori Roger Maltbie
Lance Ten Broeck Bill Britton Duffy Waldorf Don Shirey
Scott Simpson Steve Jones Bill Glasson Bobby Wadkins
Pat McGowan Ted Schulz David Ogrin Don Pooley
Dan Forsman Rocco Mediate Mike Hulber t Mike Sullivan

TECHNICAL SUPPORT

If you have questions about the program, our Technical Support Department can help. If
your question isn’t urgent, please write to us at: 

Electronic Ar ts Technical Suppor t
P.O. Box 7578
San Mateo, CA 94403-7578

Please be sure to include the following information in your letter: 

• Product name
• Type of computer you own
• Any additional system information (like type and make of monitor, video card,

printer, modem etc.)
• Type of operating system or DOS version number
• Description of the problem you’re having
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If you need to talk to someone immediately, call us at (415) 572-ARTS Monday though
Friday between 8:30 am and 4:30 pm, Pacific Time. Please have the above information
ready when you call. This will help us answer your question in the shortest possible time. 

If you live outside of the United States, you can contact one of our other offices.

In the United Kingdom, contact: Electronic Arts Limited, P.O. Box 835, Slough SL3 8XU, UK.
Phone (753) 546 465.

In Australia, contact: Electronic Arts Pty Ltd. P.O. Box 432, Southport, Qld 4215, Australia. 

Within Australia call: (075) 711 811. 

Within New Zealand call: +61 75 711 811 between 9am-5pm Eastern Standard Time.

About our company: We’re an association of electronic ar tists who share a common goal.
We want to fulfill the potential of personal computing. That’s a tall order. But with enough
imagination and enthusiasm we think there’s a good chance for our success. Products like
this are evidence of our intent.

LIMITED WARRANTY

Electronic Ar ts (“EA”) provides to the original purchaser of the computer software product,
for a period of ninety (90) days from the date of original purchase (the “Warranty Period”),
the following limited warranties:

Media — EA warrants that, under normal use, the magnetic media and the packaging pro-
vided with it are free from defects in materials and workmanship.

Software — EA warrants that the software, as originally purchased, will perform substan-
tially in conformance with the specifications set forth in the packaging and in the user man-
ual. 

WARRANTY CLAIMS

To make a warranty claim under this limited warranty, please return the product to the point
of purchase, accompanied by proof of purchase, your name, your return address, and a
statement of the defect. OR send the disk(s) to us at the above address within 90 days of
purchase. Include a copy of the dated purchase receipt, your name, your return address,
and a statement of the defect. EA or its authorized dealer will, at our option, repair or
replace the product and return it to you (postage prepaid) or issue you with a credit equal
to the purchase price. 

To replace defective media after the 90-day warranty period has expired, send the original
disk(s) to the above address. Enclose a statement of the defect, your name, your return
address, and a check or money order for $7.50. 
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The foregoing states the purchaser’s sole and exclusive remedy for any breach of warran-
ty with respect to the software product.

Warranty Exclusions: EA expressly disclaims any implied warranties with respect to the
media and the software, including warranties of merchantability or fitness for a particular
purpose. Any warranties implied by law are limited in duration to the warranty period. Some
states do not allow limitations on the duration of an implied warranty, so the above limita-
tions may not apply to you. This warranty gives you specific legal rights. You may also have
other rights which vary from state to state.

LIMITATION ON DAMAGES

EA shall not in any case be liable for incidental, consequential, or other indirect damages
arising from any claim under this agreement, even if EA or its agents have been advised of
the possibility of such damages. Some states do not allow the exclusion or limitation of
incidental or consequential damages, so the above limitation or exclusion may not apply to
you.

Unless indicated otherwise, all software and documentation is © 1990 Electronic Ar ts. All
Rights Reserved.
IBM is a registered trademark of International Business Machines, Corp.
Tandy is a registered trademark of Tandy Corporation.
Ad Lib is a registered trademark of Ad Lib, Inc.

NOTICE

ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS IN THE PRODUCT
DESCRIBED IN THIS MANUAL AT ANY TIME AND WITHOUT NOTICE.

THIS MANUAL, AND THE SOFTWARE DESCRIBED IN THIS MANUAL, IS COPYRIGHTED. ALL
RIGHTS ARE RESERVED. NO PART OF THIS MANUAL OR THE DESCRIBED SOFTWARE MAY
BE COPIED, REPRODUCED, TRANSLATED OR REDUCED TO ANY ELECTRONIC MEDIUM OR
MACHINE-READABLE FORM WITHOUT THE PRIOR WRITTEN CONSENT OF ELECTRONIC
ARTS, P. O. BOX 7578, SAN MATEO, CALIFORNIA 94403-7578, ATTN: CUSTOMER SERVICE.

ELECTRONIC ARTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO
THIS MANUAL, ITS QUALITY, MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PUR-
POSE. THIS MANUAL IS PROVIDED “AS IS.” ELECTRONIC ARTS MAKES CERTAIN LIMITED
WARRANTIES WITH REGARD TO THE SOFTWARE AND THE MEDIA FOR THE SOFTWARE.
PLEASE SEE THE ELECTRONIC ARTS LIMITED WARRANTY.

SOFTWARE ©1990 STERLING SILVER SOFTWARE AND ELECTRONIC ARTS. ALL RIGHTS RESERVED.
MANUAL BY R.J. BERG AND ERIC LINDSTROM
© 1990 ELECTRONIC ARTS. ALL RIGHTS RESERVED. 
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NOTE

 

This manual and the software described in it are copyrighted, with all
rights reserved. Under the copyright laws, this manual or the software may
not be copied, in whole or part, without written consent of Electronic
Arts, except in the normal use of the software or to make a backup copy
of the software. The same proprietary and copyright notices must be
affixed to any permitted copies as were affixed to the original. This excep-
tion does not allow copies to be made for others, whether or not sold, but
all of the material purchased (with all backup copies) may be sold, given,
or loaned to another person. Under the law, copying includes translating
into another language or format.

You may use the software on any computer owned by you, but extra
copies cannot be made for this purpose.
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